Junos® Pulse Gateway

MAG-CM060 Administration Guide
# Abbreviated Table of Contents

<table>
<thead>
<tr>
<th>Part</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>About This Guide</td>
<td>xiii</td>
</tr>
<tr>
<td>Part 1</td>
<td>Chassis Management Card Overview</td>
<td></td>
</tr>
<tr>
<td>Chapter 1</td>
<td>Installing the Chassis Management Card</td>
<td>3</td>
</tr>
<tr>
<td>Part 2</td>
<td>Introduction to J-Web</td>
<td></td>
</tr>
<tr>
<td>Chapter 2</td>
<td>Managing the MAG-CM060 with J-Web</td>
<td>13</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Using the J-Web User Interface</td>
<td>15</td>
</tr>
<tr>
<td>Chapter 4</td>
<td>Using the Dashboard</td>
<td>21</td>
</tr>
<tr>
<td>Chapter 5</td>
<td>Overview of Commands</td>
<td>25</td>
</tr>
<tr>
<td>Chapter 6</td>
<td>Configuring SSO</td>
<td>29</td>
</tr>
<tr>
<td>Part 3</td>
<td>Using the CLI</td>
<td></td>
</tr>
<tr>
<td>Chapter 7</td>
<td>CLI Overview</td>
<td>35</td>
</tr>
<tr>
<td>Chapter 8</td>
<td>Getting Started: A Quick Tour</td>
<td>39</td>
</tr>
<tr>
<td>Chapter 9</td>
<td>Getting Online Help</td>
<td>47</td>
</tr>
<tr>
<td>Chapter 10</td>
<td>CLI Commands for Monitoring the Junos Pulse Gateway</td>
<td>53</td>
</tr>
<tr>
<td>Chapter 11</td>
<td>CLI Commands for Controlling the Junos Pulse Gateway</td>
<td>69</td>
</tr>
<tr>
<td>Chapter 12</td>
<td>Commonly Used Commands With the Junos Pulse Gateway</td>
<td>77</td>
</tr>
<tr>
<td>Part 4</td>
<td>Index</td>
<td></td>
</tr>
<tr>
<td>Index</td>
<td></td>
<td>81</td>
</tr>
</tbody>
</table>
Table of Contents

About This Guide ......................................................... xiii
Document Conventions .................................................. xiii
Requesting Technical Support ......................................... xiii
   Self-Help Online Tools and Resources ................................. xiv
   Opening a Case with JTAC ........................................... xiv

Part 1  Chassis Management Card Overview

Chapter 1  Installing the Chassis Management Card ............... 3
   Chassis Management Card Overview ................................ 3
   Installing a Chassis Management Card ............................... 5
   Connecting the CMC to a Network ................................. 5
   Powering On the CMC ................................................. 6
   Configuring Basic Settings ........................................... 6
   Enabling Secure Web Access ......................................... 8
      Generating and Loading a Local Certificate .................. 8
      Internet Explorer and Certificates ............................ 9

Part 2  Introduction to J-Web

Chapter 2  Managing the MAG-CM060 with J-Web ................ 13
   Starting the J-Web Interface ........................................ 13
   Managing J-Web Sessions ............................................ 13
      Terminating J-Web Sessions .................................... 13
      Setting J-Web Session Limits ................................... 14
      Viewing Current Users ......................................... 14

Chapter 3  Using the J-Web User Interface ............................ 15
   J-Web Overview ..................................................... 15
   J-Web Layout ........................................................ 16
   Top Pane Elements .................................................. 16
   Main Pane Elements ................................................ 17
   Side Pane Elements ................................................ 18
   Navigating the J-Web Interface ..................................... 19

Chapter 4  Using the Dashboard ......................................... 21
   About the Dashboard ................................................ 21
      System Information Panel ....................................... 21
      Health Status Panel .............................................. 22
      Alarms Panel ........................................................ 22
      Chassis Viewer .................................................... 22
Chapter 5  Overview of Commands ................................................. 25
Summary of Commands ......................................................... 25

Chapter 6  Configuring SSO ....................................................... 29
Configuring Single Sign-On on the CMC .................................. 29
Configuring SSO Role Mapping for Application Acceleration Service . 30
Loading the Certificate on the Service Module ......................... 31
Single Signing-In to a Service Module ..................................... 32
Troubleshooting SSO ............................................................. 32

Part 3  Using the CLI

Chapter 7  CLI Overview .......................................................... 35
Introducing the Junos OS Command-Line Interface .................... 35
Key Features of the CLI .......................................................... 35
Understanding the Junos OS CLI Modes, Commands, and Statement Hierarchies ......................................................... 36
Junos OS CLI Command Modes ............................................. 36
CLI Command Hierarchy ......................................................... 37
Configuration Statement Hierarchy ......................................... 37
Moving Among Hierarchy Levels ............................................. 37
Other Tools for Configuring and Monitoring Devices Running Junos OS .... 38

Chapter 8  Getting Started: A Quick Tour ................................. 39
Getting Started with the Junos OS Command-Line Interface ........... 39
Switching Between Junos OS CLI Operational and Configuration Modes .... 40
Configuring a User Account on a Device Running Junos OS .......... 41
Checking the Status of a Device Running Junos OS .................. 43
Rolling Back Junos OS Configuration Changes ......................... 44

Chapter 9  Getting Online Help .................................................. 47
Getting Online Help from the Junos OS Command-Line Interface ....... 47
Getting Help For Commands .................................................. 47
Getting Help For a String in a Statement or Command .................. 48
Getting Help For Configuration Statements ............................... 49
Getting Help For System Log Messages .................................... 49
Junos OS CLI Online Help Features ......................................... 49
Help for Omitted Statements .................................................. 49
Using CLI Command Completion .......................................... 50
Using Command Completion in Configuration Mode ..................... 50
Displaying Tips For CLI Commands ....................................... 50
Displaying the Junos OS CLI Command and Word History ............ 51

Chapter 10  CLI Commands for Monitoring the Junos Pulse Gateway ...... 53
show chassis alarms ......................................................... 54
show chassis environment .................................................. 55
show chassis fan ............................................................... 57
show chassis firmware ....................................................... 58
show chassis fpc ............................................................... 59
show chassis hardware ....................................................... 61
show chassis routing-engine ................................................. 64
show snmp mib .............................................................. 66

Chapter 11  CLI Commands for Controlling the Junos Pulse Gateway ............... 69
request system halt ......................................................... 70
request system power-off ............................................... 71
request system software rollback ...................................... 72
set chassis fpc .................................................................. 73
set system services web-management session ....................... 74
request system zeroize ..................................................... 75

Chapter 12  Commonly Used Commands With the Junos Pulse Gateway .......... 77
Commands for Displaying Chassis Information ....................... 77
Validating SSO Sign-In URL ............................................... 78
Command for Checking Interfaces ....................................... 78

Part 4  Index
Index ................................................................................. 81
# List of Figures

## Part 1  Chassis Management Card Overview

**Chapter 1**  Installing the Chassis Management Card  .............................................. 3  
Figure 1: CMC J-Web Interface ................................................. 4  
Figure 2: CMC Front Panel ................................................. 4

## Part 2  Introduction to J-Web

**Chapter 3**  Using the J-Web User Interface ................................................. 15  
Figure 3: J-Web Layout .................................................. 16  
Figure 4: Top Pane Elements ................................................. 16  
Figure 5: Main Pane Elements ................................................. 18  
Figure 6: Side Pane Elements ................................................. 18

**Chapter 4**  Using the Dashboard ................................................. 21  
Figure 7: Rear View of Chassis .................................................. 22  
Figure 8: Front View of Chassis Showing Expanded Service Module ................................................. 23

**Chapter 6**  Configuring SSO ................................................. 29  
Figure 9: SSO to a Service Module ................................................. 32

## Part 3  Using the CLI

**Chapter 7**  CLI Overview .................................................. 35  
Figure 10: Committing a Configuration ................................................. 37
List of Tables

About This Guide ........................................................................ xiii
Table 1: Notice Icons ................................................................. xiii

Part 1 Chassis Management Card Overview
Chapter 1 Installing the Chassis Management Card ...................... 3
Table 2: CMC Front Panel .......................................................... 4

Part 2 Introduction to J-Web
Chapter 4 Using the Dashboard .................................................. 21
Table 3: System Information ....................................................... 21
Table 4: Health Status ............................................................... 22

Chapter 5 Overview of Commands .............................................. 25
Table 5: Summary of J-Web Commands ....................................... 26

Part 3 Using the CLI
Chapter 7 CLI Overview ............................................................ 35
Table 6: CLI Configuration Mode Navigation Commands ............... 38
About This Guide

• Document Conventions on page xiii
• Requesting Technical Support on page xiii

Document Conventions

Table 1 on page xiii defines notice icons used in this guide.

Table 1: Notice Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>i</td>
<td>Informational note</td>
<td>Indicates important features or instructions.</td>
</tr>
<tr>
<td>!</td>
<td>Caution</td>
<td>Indicates a situation that might result in loss of data or hardware damage.</td>
</tr>
<tr>
<td>⚠</td>
<td>Warning</td>
<td>Alerts you to the risk of personal injury or death.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Laser warning</td>
<td>Alerts you to the risk of personal injury from a laser.</td>
</tr>
</tbody>
</table>

Requesting Technical Support

Technical product support is available through the Juniper Networks Technical Assistance Center (JTAC). If you are a customer with an active J-Care or JNASC support contract, or are covered under warranty, and need post-sales technical support, you can access our tools and resources online or open a case with JTAC.

• Product warranties—For product warranty information, visit http://www.juniper.net/support/warranty.
JTAC hours of operation—The JTAC centers have resources available 24 hours a day, 7 days a week, 365 days a year.

Self-Help Online Tools and Resources

For quick and easy problem resolution, Juniper Networks has designed an online self-service portal called the Customer Support Center (CSC) that provides you with the following features:

- Find CSC offerings: http://www.juniper.net/customers/support/
- Search for known bugs: http://www2.juniper.net/kb/
- Find product documentation: http://www.juniper.net/techpubs/
- Find solutions and answer questions using our Knowledge Base: http://kb.juniper.net/
- Download the latest versions of software and review release notes: http://www.juniper.net/customers/csc/software/
- Search technical bulletins for relevant hardware and software notifications: https://www.juniper.net/alerts/
- Join and participate in the Juniper Networks Community Forum: http://www.juniper.net/company/communities/
- Open a case online in the CSC Case Management tool: http://www.juniper.net/cm/

To verify service entitlement by product serial number, use our Serial Number Entitlement (SNE) Tool: https://tools.juniper.net/SerialNumberEntitlementSearch/

Opening a Case with JTAC

You can open a case with JTAC on the Web or by telephone.

- Use the Case Management tool in the CSC at http://www.juniper.net/cm/.
- Call 1-888-314-JTAC (1-888-314-5822 toll-free in the USA, Canada, and Mexico).

For international or direct-dial options in countries without toll-free numbers, see http://www.juniper.net/support/requesting-support.html.
PART 1

Chassis Management Card Overview

• Installing the Chassis Management Card on page 3
CHAPTER 1

Installing the Chassis Management Card

- Chassis Management Card Overview on page 3
- Installing a Chassis Management Card on page 5
- Connecting the CMC to a Network on page 5
- Powering On the CMC on page 6
- Configuring Basic Settings on page 6
- Enabling Secure Web Access on page 8

Chassis Management Card Overview

The Junos Pulse Gateway CMC is an optional management module that you can install on a MAG6610 and MAG6611. No more than one CMC is ever installed on a Junos Pulse Gateway. The CMC runs the Junos OS.

The CMC provides a visual representation of the Junos Pulse Gateway chassis and all installed modules. You can view all installed modules using either the CLI or the J-Web interface.

Another benefit of the CMC is that it provides SSO to all modules through a single IP address and launches that module’s administrative user interface.
The CMC uses a dedicated reserved slot in the MAG6610 or MAG6611 chassis. At most one CMC should be installed per chassis.

Figure 2 on page 4 shows the CMC front panel.

Table 2 on page 4 lists the CMC front panel components.

<table>
<thead>
<tr>
<th>Number</th>
<th>Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Console</td>
</tr>
<tr>
<td>2</td>
<td>Ethernet ports 0 (em0) and 1 (em1)</td>
</tr>
<tr>
<td>3</td>
<td>USB port</td>
</tr>
<tr>
<td>4</td>
<td>LEDs (power, activity, alarm)</td>
</tr>
<tr>
<td>5</td>
<td>Power button</td>
</tr>
</tbody>
</table>
Installing a Chassis Management Card

The chassis management card (CMC) can be installed in an even-numbered slot (for example, slot 0 or slot 2) in an installed service module.

To install a CMC in a MAG6610 or MAG6611:

1. Power off the device by pressing and holding the power switch located on the back of the Junos Pulse Gateway chassis for 5 to 10 seconds.
2. Attach an electrostatic discharge (ESD) grounding strap to your bare wrist, and connect the strap to the grounding point on the back of the device.
3. Gently pry the blank faceplate from the chassis using your fingers or a flat-blade screwdriver.
4. Using a Phillips screwdriver, remove the two screws retaining the metal faceplate, and then remove the metal faceplate.
5. Grasp the faceplate of the CMC, and align the notches in the connector at the rear of the CMC with the notches in the service module.
6. Slide in the CMC until it lodges firmly in the device.
7. Tighten the thumb screws until they are finger tight.

Connect the CMC to a management console before powering up the Junos Pulse Gateway. Connect a serial cable to the port labeled CONSOLE on the CMC front panel, and connect the other end of the serial cable to the serial port on the management device.

Connecting the CMC to a Network

The CMC has two Ethernet ports:

- 0 (em0)
- 1 (em1) - reserved

Connect port 0 to your management network.

**NOTE:** Configure only port 0; do not connect anything to port 1 or configure port 1. Port 1 is currently reserved.

SSO requires a common subnet on the ethernet port 0 (em0) of the CMC and certain service module ethernet ports. For Secure Access Service and Access Control Service, if the management port is enabled then the management port should be in the same subnet as that for em0. Otherwise the internal port of Secure Access Service or Access Control Service should be in the same subnet as that for em0. When this condition is met, the service module will automatically detect the em0's IP address and inter-chassis communication, including SSO, is possible.
Powering On the CMC

The CMC turns on automatically when you power on the Junos Pulse Gateway. When it is completely operational, the CMC then turns on the installed service modules (or leaves them turned off) according to the saved configuration.

The saved configuration stores the state the service modules should be in (either on or off) when the Junos Pulse Gateway or CMC starts. For example, if the service module is set to off in the configuration, when the Junos Pulse Gateway or CMC restarts, that service module remains turned off until you explicitly turn it on.

NOTE: The configuration overrides the current state of the service modules. For example, momentarily push the recessed reset button on a service module to turn it off. If that service module is set to on in the configuration, the next time the Junos Pulse Gateway or CMC restarts, that service module will power up.

You can edit the configuration using the CLI described later. By default, all installed service modules power on.

Use the power button on the CMC front panel to turn off or on the CMC independent of the installed service modules.

Configuring Basic Settings

Run the `ezsetup` script from your management console to set general network connectivity settings on the CMC. You can then use the J-Web interface or CLI to complete the configuration process.

NOTE: To use the CMC to SSO to an application module, at least one port on that application module must be on the same subnet as CMC port 0 (em0). For Secure Access Service and Access Control Service, if the management port is enabled then the management port should be in the same subnet as that for em0. Otherwise the internal port of Secure Access Service or Access Control Service should be in the same subnet as that for em0. When this condition is met, the service module will automatically detect the em0’s IP address and inter-chassis communication, including SSO, is possible.
To run the `ezsetup` script:

1. Configure a console terminal or terminal emulation utility (such as HyperTerminal) running on a computer to use the following serial connection parameters:
   - 9600 bits per second
   - 8-bit no parity (8N1)
   - 1 stop bit
   - No flow control
2. Press Enter repeatedly until you see a system command prompt.
3. Type `ezsetup` and press Return.
4. Follow the script prompts, as shown below:

```
root% ezsetup
************************************************************************
* EZSetup wizard
* Use the EZSetup wizard to configure the identity of the chassis.
* Once you complete EZSetup, the chassis can be accessed over the network.
* To exit the EZSetup wizard press CTRL+C.
* In the wizard, default values are provided for some options.
* Press ENTER key to accept the default values.
* Prompts that contain [Optional] denotes that the option is not mandatory. Press ENTER key to ignore the option and continue.

************************************************************************

Initial Setup Configuration
----------------------------

Enter System hostname [Optional]:

Enter new root password:
Re-enter the new password:

Enable Telnet service? [yes|no]. Default [no]:
Enable SSH service? [yes|no]. Default [yes]:

Configure management interface [em0.0]
Enter Management IP address:
Enter Subnetmask [255.255.0.0]:
Enter Gateway IP address:

Configure SNMP [yes|no], default [yes]:

Enter System Time and Date YYYY:MM:DD:hh:mm:ss [Optional]:

Time Zone [Optional], Enter "yes" to choose Timezone from list:

The input configuration parameters are
Commit the new configuration?
Choosing option "yes" will add new configuration to existing configuration.
Option "No" will allow user to come out of EZSetup wizard.

Choose option [yes|no], default [yes]:

5. At the “Commit the new configuration?” prompt, enter Yes to continue or No to discard your edits and exit the ezsetup script.

NOTE: If you need to rerun ezsetup, you must first clear the configuration information and start the CMC from the factory state. To do this, enter the command request system zeroize prior to rerunning ezsetup.

Enabling Secure Web Access

The CMC uses the Secure Sockets Layer (SSL) protocol to provide secure management through the Web interface. SSL uses public-private key technology that requires a paired private key and an authentication certificate for the SSL service. SSL encrypts communication between the CMC and the Web browser with a session key negotiated using the SSL server certificate.

The ezsetup script automatically configures the management interface of the CMC to use a system-generated certificate for all SSL requests. You may choose to use a device certificate from a trusted Certificate Authority (CA). If you plan to configure SSO to your service modules, the service modules require the device certificate from the CMC. You can use either a system-generated certificate or a certificate from a CA for SSO to the service modules.

To configure web access for CMC using a system-generated certificate, run the following commands at the CLI prompt:

```
> edit
> set system services web-management http port 80 interface em0.0
> set system services web-management https port 443 system-generated-certificate interface em0.0
> commit
```

You can also configure the system to use other certificates such as a digital SSL certificate.

Generating and Loading a Local Certificate

This section describes one process for generating and loading a local certificate. In this example, the name of the local digital certificate and the public/private key pair is CERTI.

1. Generate the key pair.

```
> request security pki generate-key-pair size 1024 type rsa certificate-id CERTI
```

2. Generate a local digital certificate request.
3. Copy and paste the certificate request generated by the `request security pki` command in Step 2 into the certificate authority (CA) server with a SSL server certificate (certificate usage of “certUsageSSLServer” which is translated to a key usage of KEY_AGREEMENT or KEY_ENCIIPHERMENT and a certificate type of SSL_SERVER).

4. Save the certificate and copy it to the MAG-CM060 using FTP or SCP. In this example, the local digital certificate provided by the CA is named `certnew.cer` and is located on the CMC in `/var/tmp`.

5. Load the certificate using the following command.

   ```
   > request security pki local-certificate load filename /var/tmp/certnew.cer certificate-id CERT1
   ```

6. Associate this certificate (CERT1) with https.

   ```
   configure
   # set system services web-management https port 443 interface em0.0
   pki-local-certificate CERT1
   ```

7. Make sure that http is configured on the CMC. If it is not, configure it using following command:

   ```
   # set system services web-management http port 80 interface em0.0
   ```

8. If the root CA certificate is not available in the browser it must be loaded first.


   After http:// or https:// in your Web browser, type the IP address of the CMC and press Enter.

**Internet Explorer and Certificates**

If you are using Internet Explorer, you may encounter some errors with certificates that have a Subject Alternate Name (SAN) field. Even though the certificate is valid, Internet Explorer will report an invalid certificate for the following cases:

- certificate subject has domain name and subject alternate name has ip address
- certificate subject has ip address and subject alternate name has domain name
- both certificate subject and subject alternate name have ip addresses

In all of the above cases, even if the certificate is issued to the correct IP address and you are accessing the URL using an IP address, Internet Explorer warns that the certificate is not valid. All other browsers do not exhibit this behavior.

If you use Internet Explorer to access J-Web, use one of the following command to generate the certificate request. Replace the variables with values appropriate for your company.

```
request security pki generate-certificate-request certificate-id CERT1 subject CN=cmc189.juniper.net, OU=Engineering, O=JuniperNetworks, L=Sunnyvale, ST=California, C=US email youremail@yourcompany.com
```
request security pki generate-certificate-request certificate-id CERT1 subject CN=10.204.88.189, OU=Engineering, O=JuniperNetworks, L=Sunnyvale, ST=California, C=US email youremail@yourcompany.com
PART 2

Introduction to J-Web

- Managing the MAG-CM060 with J-Web on page 13
- Using the J-Web User Interface on page 15
- Using the Dashboard on page 21
- Overview of Commands on page 25
- Configuring SSO on page 29
CHAPTER 2

Managing the MAG-CM060 with J-Web

• Starting the J-Web Interface on page 13
• Managing J-Web Sessions on page 13

Starting the J-Web Interface

Before you start the user interface, you must perform the initial configuration ("ezsetup script") described in “Configuring Basic Settings” on page 6. After the initial configuration, use the username and password and the hostname or IP address of the chassis management card (CMC) to start the user interface.

To start the J-Web interface:

1. Launch a Web browser that has Hypertext Transfer Protocol (HTTP) or HTTP over Secure Sockets Layer (HTTPS) enabled.
   The J-Web login page appears.
3. On the login page, type the username and password, and click Log In.
   When you attempt to log in through the J-Web interface, the CMC authenticates your username with the same methods used for Telnet and SSH.
   To correct or change the username or password you typed, click Reset, type the new entry or entries, and click Log In.

Managing J-Web Sessions

You establish a J-Web session with the CMC through an HTTP-enabled or HTTPS-enabled Web browser. To use HTTPS, you must have installed a certificate on the CMC and enabled HTTPS.

Terminating J-Web Sessions

To explicitly terminate a J-Web session at any time, click Logout in the top pane. You must log in again to begin a new session.
By default, if the CMC does not detect any activity through the J-Web interface for 10 minutes, the session times out and is terminated.

**Setting J-Web Session Limits**

By default, an unlimited number of users can log in to the J-Web interface. Using CLI commands, you can limit the maximum number of simultaneous J-Web user sessions and set a default session timeout for all users.

- To limit the number of simultaneous J-Web user sessions, enter the following commands:
  ```
  user@host# edit system services web-management session
  user@host# set session-limit session-limit
  ```
  The range is 1 through 1024; the default is unlimited.

- To change the J-Web session idle time limit, enter the following commands:
  ```
  user@host# edit system services web-management session
  user@host# set idle-timeout minutes
  ```
  The range is 1 through 1440; the default is 1440.

You can also configure the maximum number of simultaneous subordinate HTTP processes created in response to user requests.

To configure the maximum number of subordinate httpd processes, enter the following commands:

```
user@host# edit system services web-management limits
user@host# active-child-process process-limit
```

The range is 0 through 32; the default is 5.

For more information about system services statements, see the JUNOS System Basics Configuration Guide.

**Viewing Current Users**

To view a list of users logged in to the CMC, select Monitor>System View>System Information in J-Web and scroll down to the Users section, or enter the show system users command in the CLI. The J-Web page and CLI output show all users logged in to the CMC from either J-Web or the CLI.
CHAPTER 3

Using the J-Web User Interface

• J-Web Overview on page 15
• J-Web Layout on page 16
• Top Pane Elements on page 16
• Main Pane Elements on page 17
• Side Pane Elements on page 18
• Navigating the J-Web Interface on page 19

J-Web Overview

The J-Web interface allows you to monitor, configure, troubleshoot, and manage the chassis management card (CMC) installed in the Junos Pulse Gateway by means of a Web browser enabled with HTTP over Secure Sockets Layer (HTTPS). J-Web provides access to all the configuration statements, so you can fully configure it without using the Junos CLI.

You can perform the following tasks with the J-Web interface:

• Monitoring—Display the current configuration and information about the Junos Pulse Gateway.

• Single Sign-On—Configure single sign-on (SSO) so that you can access the admin console of the installed service module without having to enter credentials each time.

• Configuring—View the current configurations at a glance, configure the CMC, and manage configuration files. The J-Web interface provides the following different configuration methods:
  • Edit a graphical version of the Junos CLI configuration statements and hierarchy.
  • Edit the configuration in a text file.
  • Upload a configuration file.

The J-Web interface also allows you to manage configuration history and set a rescue configuration.

• Diagnosing—Diagnose routing problems by running the ping or traceroute diagnostic tool. The diagnostic tools also allow you to capture and analyze routing platform control traffic.
- Managing—Manage log, temporary, and core (crash) files. You can also manage software packages and licenses.
- Configuring and monitoring events—Filter and view system log messages that record events occurring on the CMC. You can configure files to log system log messages and can also assign attributes, such as severity levels, to messages.
- Configuring and monitoring alarms—Monitor and diagnose the CMC by monitoring active alarms that alert you to the conditions on a network interface. You can also set the conditions that trigger alarms on an interface.

NOTE: The J-Web interface uses the term FPC to refer to cards (CMC or application modules) installed in the Junos Pulse Gateway.

### J-Web Layout

Each page of the J-Web interface is divided into the following panes, as described and shown in Figure 3 on page 16.

- Top pane—Displays identifying information and links.
- Main pane—Location where you configure, monitor, maintain and troubleshoot the CMC by entering information in text boxes, making selections, and clicking buttons.
- Side pane—Displays subtasks of the Configure, Monitor, Maintain and Troubleshoot task currently displayed in the main pane. For the configuration editor, this pane displays the hierarchy of configuration statements committed on the routing platform. Click an item to access it in the main pane.

Figure 3: J-Web Layout

### Top Pane Elements

The top pane comprises the elements shown in Figure 4 on page 16.

Figure 4: Top Pane Elements
• **hostname** – **address**—Hostname and IP address.

• **Logged in as:** **username**—Username you used to log in to the routing platform.

**Commit Options**

• **Commit**—Commits the candidate configuration. Changes made by other users as well as changes made in other J-Web sessions will be committed.

• **Compare**—Displays the differences between the committed and uncommitted configuration on the device.

• **Discard**—Discards the candidate configuration. Changes made by other users as well as changes made in other J-Web sessions will be discarded.

• **Preference**—Enables you to select preferences for committing configuration. **Commit Check** only validates the configuration and reports errors. **Commit** validates and commits the configuration specified on every J-Web page.

**Help**

• **Help Contents**—Link to context-sensitive help information.

• **About**—Link to information about the J-Web interface, such as the version number.

• **Logout**—Ends your current login session with the routing platform and returns you to the login page.

• **Taskbar**—Menu of J-Web tasks. Click a J-Web task to access it.

  • **Configure**—Configure the CMC with Configuration pages or the configuration editor, and view configuration history.

  • **Monitor**—View information about configuration and hardware.

  • **Maintain**—Manage files and licenses, upgrade software, and reboot the CMC.

  • **Troubleshoot**—Troubleshoot network connectivity problems.

**Main Pane Elements**

The main pane comprises the elements shown in Figure 5 on page 18.

After you click a tab in the top pane (for example, the Configure tab, the Monitor tab, and so forth), the main J-Web pane remains blank. You must click a subtask (such as Configure > SNMP) to view content.
Figure 5: Main Pane Elements

- Help (?) icon—Displays useful information when you move the cursor over the question mark. This help displays field-specific information, such as the definition, format, and valid range of the field.
- Red asterisk (*)—Indicates a required field.

Side Pane Elements

The side pane comprises the elements shown in Figure 6 on page 18.

Figure 6: Side Pane Elements

- Configuration hierarchy—For the J-Web configuration editor, displays the hierarchy of committed statements in the routing platform configuration.
  - Click **Expand all** to display the entire hierarchy.
  - Click **Hide all** to display only the statements at the top level.
Navigating the J-Web Interface

The layout of the panes allows you to quickly navigate through the interface. You navigate the J-Web interface, move forward and backward, scroll pages, and expand and collapse elements as you do in a typical Web browser interface.

From the taskbar, select the J-Web task that you want to perform. Selecting the task displays related subtasks in the side pane. When you select a subtask, related fields are displayed in the main pane. By default, the system selects the first subtask and displays its related fields in the main pane. The side pane and taskbar are available from all pages, allowing you to skip from one task or subtask to the other from any page in the interface.

You can easily navigate to most subtasks by selecting them from the side pane. On pages where you are required to take an action, buttons and links allow you to move to the next or previous page as you perform certain actions.
CHAPTER 4

Using the Dashboard

• About the Dashboard on page 21

About the Dashboard

When you log in to the J-Web user interface, the Dashboard for the Junos Pulse Gateway appears. Use the Dashboard to view system information and to single sign-on (SSO) into the installed modules. The Dashboard comprises three panels and a graphical chassis viewer. You can click Preferences to choose which panels to display and set the refresh interval for chassis viewer information. Click OK to save your preference changes and return to the Dashboard, or click Cancel to return to the Dashboard without saving changes.

NOTE: You can drag and drop the various panels to different locations in the J-Web window.

The number of panels and the information displayed in each panel change when you click a module in the chassis viewer.

System Information Panel

Table 3 on page 21 lists the information displayed in the System Information panel.

Table 3: System Information

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Name</td>
<td>The local name of the CMC.</td>
</tr>
<tr>
<td>Device Model</td>
<td>The model of the Junos Pulse Gateway or the application module if selected in the chassis viewer.</td>
</tr>
<tr>
<td>Inventory</td>
<td>The values in inventory are displayed as 1-2 RE, 1-4 FPC. RE is a term for the Routing Engine module. For Junos Pulse Gateway, this refers to the CMC. FPC is a term for a Flexible PIC Concentrator (slot) in a Juniper Networks chassis.</td>
</tr>
<tr>
<td>Boot Image</td>
<td>The software version currently installed and in use.</td>
</tr>
</tbody>
</table>
Table 3: System Information (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial Number</td>
<td>System or device serial number.</td>
</tr>
<tr>
<td>Device Uptime</td>
<td>The time since the last reboot.</td>
</tr>
<tr>
<td>Current Time</td>
<td>Current local time.</td>
</tr>
<tr>
<td>Last Configured Time</td>
<td>The time when the Junos Pulse Gateway was last configured.</td>
</tr>
<tr>
<td>Device Type</td>
<td>The type of module. For example, Junos Pulse Gateway Secure Access Service.</td>
</tr>
<tr>
<td>Device State</td>
<td>Displays the current state of the application module (available only when an application module is selected in the chassis viewer).</td>
</tr>
</tbody>
</table>

**NOTE:** Device state values are online and offline. This value does not distinguish between power on/off and online/offline.

Health Status Panel

Table 4 on page 22 lists the information displayed in the Health Status panel.

Table 4: Health Status

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Util.</td>
<td>Indicates the memory used in the Junos Pulse Gateway.</td>
</tr>
<tr>
<td>CPU Load</td>
<td>Indicates the average CPU usage over the previous 15 minutes.</td>
</tr>
</tbody>
</table>

Alarms Panel

The Alarms panel displays information about the last five alarms raised in the system. For example, if there are 5 major alarms, then details for all 5 major alarms are displayed. If there are 4 major alarms and 3 minor alarms, then details of the 4 major alarms and 1 minor alarm are displayed. Major alarms are displayed in red, and minor alarms are displayed in yellow.

Chassis Viewer

Click the **Rear View** or **Front View** button to view the back or front chassis image. Mouse over items on the rear view to see more information, such as status.

Figure 7: Rear View of Chassis
From the front view, click the chassis management card (CMC) or service module to see an expanded view. From the expanded view, you can view port status (CMC-only) or temperature status by mouse over (service module-only) and click the arrow to single-sign on (SSO) to a service module.

Figure 8: Front View of Chassis Showing Expanded Service Module
CHAPTER 5

Overview of Commands

• Summary of Commands on page 25

Summary of Commands

Table 5 on page 26 lists the available J-Web commands. For more information on these commands, see the J-Web User Interface Guide located on the Juniper Networks Technical Documentation page.
### Table 5: Summary of J-Web Commands

<table>
<thead>
<tr>
<th>Tab</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure</td>
<td>Interfaces</td>
<td>Configure physical and logical interface properties. For the physical interface, you can modify default values for general interface properties, such as the interface's MTU size, link operational mode, and clock source. For each logical interface, you can specify the protocol family and other logical interface properties.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Properties</td>
<td>Configure system management functions, including the hostname, address, and domain name; the addresses of DNS servers.</td>
</tr>
<tr>
<td></td>
<td>&gt; System Identity</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Properties</td>
<td>Enable HTTP and HTTPS access.</td>
</tr>
<tr>
<td></td>
<td>&gt; Management Access</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Properties</td>
<td>Configures the CMC login names and authentication method.</td>
</tr>
<tr>
<td></td>
<td>&gt; User Management</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Properties</td>
<td>Configures the network port and sign-in URL path used to SSO to an application module.</td>
</tr>
<tr>
<td></td>
<td>&gt; Blade Single Sign On</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&gt; General Settings</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Properties</td>
<td>For future use.</td>
</tr>
<tr>
<td></td>
<td>&gt; Blade Single Sign On</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&gt; Role Mapping</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Properties</td>
<td>Synchronizes the system time with the NTP server, or manually sets the system time and date.</td>
</tr>
<tr>
<td></td>
<td>&gt; Date Time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Properties</td>
<td>Configure SNMP to monitor network devices from a central location. You can specify an administrative contact and location and add a description for each system being managed by SNMP.</td>
</tr>
<tr>
<td></td>
<td>&gt; Services &gt; SNMP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Properties</td>
<td>Displays the entire configuration in text format.</td>
</tr>
<tr>
<td></td>
<td>&gt; CLI Tools &gt; CLI Viewer</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Properties</td>
<td>Allows editing of the entire configuration in text format.</td>
</tr>
<tr>
<td></td>
<td>&gt; CLI Tools &gt; CLI Editor</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Properties</td>
<td>Configures all properties of the Junos OS, including interfaces and user access, as well as several system hardware properties.</td>
</tr>
<tr>
<td></td>
<td>&gt; CLI Tools &gt; Point and</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Click CLI</td>
<td></td>
</tr>
</tbody>
</table>
Table 5: Summary of J-Web Commands (*continued*)

<table>
<thead>
<tr>
<th>Tab</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor</td>
<td>Interfaces</td>
<td>Displays general interface information such as available interfaces, operation states of the interfaces, and descriptions of the configured interfaces.</td>
</tr>
<tr>
<td>Events and Alarms &gt; View Alarms</td>
<td></td>
<td>Alerts you to conditions that might prevent the CMC from operating normally.</td>
</tr>
<tr>
<td>Events and Alarms &gt; View Events</td>
<td></td>
<td>Provides an easy method for viewing the events recorded in the system log (also known as <em>system log messages</em>).</td>
</tr>
<tr>
<td>System View &gt; System Information</td>
<td></td>
<td>Displays information about system properties such as the name and IP address of the CMC or the resource usage.</td>
</tr>
<tr>
<td>System View &gt; Chassis Information</td>
<td></td>
<td>Displays chassis properties.</td>
</tr>
<tr>
<td>System View &gt; Process Details</td>
<td></td>
<td>Displays process details such as process ID, CPU load, or memory utilization.</td>
</tr>
</tbody>
</table>
Table 5: Summary of J-Web Commands (continued)

<table>
<thead>
<tr>
<th>Tab</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintain</td>
<td>Files</td>
<td>Manages log, temporary, and core files.</td>
</tr>
<tr>
<td></td>
<td>Config Management</td>
<td>Uploads a configuration file from your local system.</td>
</tr>
<tr>
<td></td>
<td>History</td>
<td>Manages saved configuration files.</td>
</tr>
<tr>
<td></td>
<td>Software</td>
<td>Uploads a configuration file from your local computer.</td>
</tr>
<tr>
<td></td>
<td>Install Package</td>
<td>Installs software packages uploaded from your local computer.</td>
</tr>
<tr>
<td></td>
<td>Software</td>
<td>Install Package</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Installs software packages that are retrieved with FTP or HTTP from the location specified.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NOTE: When installing a package from a remote server using the Maintain &gt; Software &gt; Install Package window, the package installation may finish successfully while one or more of the displayed tasks still shows a “Pending” status. If a reboot option is displayed, the pending tasks can be ignored and the system can be rebooted to finalize the package installation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This is applicable when installing software using the Maintain &gt; Software &gt; Upload Package window as well.</td>
</tr>
<tr>
<td>Reboot</td>
<td></td>
<td>Reboots the CMC.</td>
</tr>
<tr>
<td>Troubleshoot</td>
<td>Ping Host</td>
<td>Verifies that the host can be reached over the network.</td>
</tr>
<tr>
<td></td>
<td>Traceroute</td>
<td>Traces a route between the CMC and a remote host.</td>
</tr>
<tr>
<td></td>
<td>Packet Capture</td>
<td>Captures and analyzes traffic.</td>
</tr>
<tr>
<td></td>
<td>CLI Terminal</td>
<td>Provides a set of commands for monitoring and configuring the CMC.</td>
</tr>
</tbody>
</table>
CHAPTER 6

Configuring SSO

- Configuring Single Sign-On on the CMC on page 29
- Configuring SSO Role Mapping for Application Acceleration Service on page 30
- Loading the Certificate on the Service Module on page 31
- Single Signing-In to a Service Module on page 32
- Troubleshooting SSO on page 32

Configuring Single Sign-On on the CMC

Administrator single sign-on (SSO) is the main feature for delivering a unified management experience. SSO allows administrators who manage service modules to seamlessly navigate to the administrative user interface of the service modules without having to provide user credentials (username and password) again.

NOTE: SSO requires a common subnet on the ethernet port 0 (em0) of the CMC and certain service module ethernet ports. For Secure Access Service and Access Control Service, if the management port is enabled then the management port should be in the same subnet as that for em0. Otherwise the internal port of Secure Access Service or Access Control Service should be in the same subnet as that for em0. When this condition is met, the service module will automatically detect the em0’s IP address and inter-chassis communication, including SSO, is possible.

When configuring for SSO, you define the URL to the service module. The URL consists of the sign-in URL IP address and the sign-in URL path. For example:

https://10.64.4.253/chassis_sso

In this example, 10.64.4.253 is the Sign-In URL IP address and chassis_sso is the Sign-In URL path.

You can configure SSO using the J-Web or the CLI. The examples in this topic use the J-Web. Notice that some elements of the configuration are automatically populated with data. This data will vary depending on the FPC that you select in the configuration.
To configure SSO:

2. Click Global Options to define the Security Assertion Markup Language (SAML) assertion timeout and to enable Simple Network Management Protocol (SNMP) traps.
3. Click Add.
4. Select the Flexible PIC Concentrator (FPC) number corresponding to the service module that you want to configure for SSO.
5. Select the network port to use to communicate to the FPC. The options are auto-select, management port, internal port and external port.
6. Enter the URL path of the FPC. The default is chassis_sso.

   NOTE: It is not necessary to enter the FPC URL path for Application Acceleration Service.

7. Click OK.

### Configuring SSO Role Mapping for Application Acceleration Service

When using SSO with an Application Acceleration Service module, you must define which users have access.

To configure role mapping for Application Acceleration Service SSO:

2. Click Add.
3. Enter the following options:
   - **Admin Name** – Enter an administrator username to allow for SSO.
   - **FPC Number** – Select the service module to allow this user to SSO.
   - **Admin Role** – Enter the user’s role to define their access level. For example, enter `super-user` to allow complete access. Valid roles are:
     - super-user – Full read/write privileges, including management of user accounts.
     - operator – Read/write configuration privileges, but no packet capture or user management privileges.
     - read-only-plus – Read-only privileges and packet capture capability.
     - read-only – Read-only privileges.
4. Click OK.
Loading the Certificate on the Service Module

After the SSO certificate is generated and loaded on the CMC, it must also be loaded on the service module.

To load the certificate into the service module:

1. Launch the admin web UI for the service module.
2. (Secure Access Service or Access Control Service only) Import the same certificate you imported into the CMC using, for example, the Authentication > Auth Server > Chassis Auth Server window.

   The Chassis Auth Server configures the appropriate login name, authentication server realm (Chassis SSO), and so forth required for SSO.

3. (Application Acceleration Service only) Select Setup > AAA > SSO Certificate Download and specify the location of the certificate.

<table>
<thead>
<tr>
<th>local disk</th>
<th>Specify the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Path and filename of the SSO certificate file on a machine in your network (click Browse to select the file).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TFTP server</th>
<th>Specify the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• IP address of a TFTP server.</td>
</tr>
<tr>
<td></td>
<td>• Path and filename of the SSO certificate file. The first character must be a slash (/).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FTP server</th>
<th>Specify the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• IP address of an FTP server.</td>
</tr>
<tr>
<td></td>
<td>• If the FTP server does not accept anonymous user access, enter a username and password for an account that has read/write privileges on the server.</td>
</tr>
<tr>
<td></td>
<td>• Path and filename of the SSO certificate file. The first character must be a slash (/).</td>
</tr>
</tbody>
</table>

**NOTE:** SSO requires a common subnet on the ethernet port 0 (em0) of the CMC and certain service module ethernet ports. For Secure Access Service and Access Control Service, if the management port is enabled then the management port should be in the same subnet as that for em0. Otherwise the internal port of Secure Access Service or Access Control Service should be in the same subnet as that for em0. When this condition is met, the service module will automatically detect the em0’s IP address and inter-chassis communication, including SSO, is possible.

For SSO to work properly, ensure that the date, time and time zone on both the CMC and service modules are the same.
Single Signing-In to a Service Module

To SSO in to a service module:

1. Start the J-Web interface. If you want to SSO in to an Application Acceleration Service module, log in using the credentials you defined in the SSO role mapping window.

2. Click Dashboard.

3. In the chassis viewer, click the service module to SSO.

4. Click the Launch SSO icon (the blue icon with the arrow pointing to the upper right).

After a few seconds, the admin web UI for that service module appears. You will not be prompted for a username and password if SSO is operating correctly.

If you did not create an SSO role map and try to SSO in to an Application Acceleration Service module, you must manually enter your credentials at the Application Acceleration Service module login window.

NOTE: If an administrator has already signed in to an Application Service Module (for example, the Secure Access Service module) and another administrator tries to SSO in to that same module, a multiple administrator session warning page appears. The second administrator can still log in to that module, however, an message for SAML Authentication failure (Empty Assertion) is incorrectly entered in the Admin logs. You can ignore this message in the Admin logs.

Troubleshooting SSO

If you have problems trying to SSO in to a service module:

- Ensure the clock setting on the service modules and the CMC are in sync.
- Ensure the same certificate is imported into both the CMC and the service module.
PART 3

Using the CLI

- CLI Overview on page 35
- Getting Started: A Quick Tour on page 39
- Getting Online Help on page 47
- CLI Commands for Monitoring the Junos Pulse Gateway on page 53
- CLI Commands for Controlling the Junos Pulse Gateway on page 69
- Commonly Used Commands With the Junos Pulse Gateway on page 77
CHAPTER 7

CLI Overview

- Introducing the Junos OS Command-Line Interface on page 35
- Understanding the Junos OS CLI Modes, Commands, and Statement Hierarchies on page 36
- Other Tools for Configuring and Monitoring Devices Running Junos OS on page 38

Introducing the Junos OS Command-Line Interface

The Junos OS command-line interface (CLI) is the software interface you use to access a device running Junos OS—whether from the console or through a network connection.

The Junos OS CLI is a Juniper Networks-specific command shell that runs on top of a FreeBSD UNIX-based operating system kernel. By leveraging industry-standard tools and utilities, the CLI provides a powerful set of commands that you can use to monitor and configure devices running Junos OS. The CLI is a straightforward command interface. You type commands on a single line, and the commands are executed when you press Enter.

Key Features of the CLI

The Junos OS CLI commands and statements follow a hierarchal organization and have a regular syntax. The Junos OS CLI provides the following features to simplify CLI use:

- Consistent command names—Commands that provide the same type of function have the same name, regardless of the portion of the software on which they are operating. For example, all `show` commands display software information and statistics, and all `clear` commands erase various types of system information.

- Lists and short descriptions of available commands—Information about available commands is provided at each level of the CLI command hierarchy. If you type a question mark (?) at any level, you see a list of the available commands, along with a short description of each command. This means that if you already are familiar with Junos OS, you can use many of the CLI commands without referring to the documentation.

- Command completion—Command completion for command names (keywords) and for command options is available at each level of the hierarchy. To complete a command or option that you have partially typed, press the Tab key or the Spacebar. If the partially typed letters begin a string that uniquely identifies a command, the
complete command name appears. Otherwise, a beep sounds, indicating that you have entered an ambiguous command, and the possible completions are displayed. Completion also applies to other strings, such as filenames, interface names, usernames, and configuration statements.

If you have typed the mandatory arguments for executing a command in the operational or configuration mode, the CLI displays `<[Enter]>` as one of the choices when you type a question mark (`?!`). This indicates that you have entered the mandatory arguments and can execute the command at that level without specifying any further options. Likewise, the CLI also displays `<[Enter]>` when you have reached a specific hierarchy level in the configuration mode and do not have to enter any more mandatory arguments or statements.

- Industry-standard technology—With FreeBSD UNIX as the kernel, a variety of UNIX utilities are available on the Junos OS CLI. For example, you can:
  - Use regular expression matching to locate and replace values and identifiers in a configuration, to filter command output, or to examine log file entries.
  - Use Emacs-based key sequences to move around on a command line and scroll through the recently executed commands and command output.
  - Store and archive Junos device files on a UNIX-based file system.
  - Use standard UNIX conventions to specify filenames and paths.
  - Exit from the CLI environment and create a UNIX C shell or Bourne shell to navigate the file system, manage processes, and so on.

Understanding the Junos OS CLI Modes, Commands, and Statement Hierarchies

The Junos OS command-line interface (CLI) commands and statements are organized under two command modes and various hierarchies. The following sections provide you an overview of the Junos OS CLI command modes and commands and statements hierarchies:

- Junos OS CLI Command Modes on page 36
- CLI Command Hierarchy on page 37
- Configuration Statement Hierarchy on page 37
- Moving Among Hierarchy Levels on page 37

Junos OS CLI Command Modes

The Junos OS CLI has two modes:

- Operational mode—This mode displays the current status of the device. In operational mode, you enter commands to monitor and troubleshoot the Junos OS, the devices, and the network connectivity.
- Configuration mode—A configuration for a device running on Junos OS is stored as a hierarchy of statements. In configuration mode, you enter these statements to define
all properties of the Junos OS, including interfaces, user access, and several system and hardware properties.

When you enter configuration mode, you are actually viewing and changing a file called the candidate configuration. The candidate configuration file enables you to make configuration changes without causing operational changes to the current operating configuration, called the active configuration. The chassis management card (CMC) does not implement the changes that you added to the candidate configuration file until you commit them, which activates the configuration on the CMC (see Figure 10 on page 37). Candidate configurations enable you to alter your configuration without potential damage to your current network operations.

Figure 10: Committing a Configuration

CLI Command Hierarchy

CLI commands are organized in a hierarchy. Commands that perform a similar function are grouped together under the same level of the hierarchy. For example, all commands that display information about the system and the system software are grouped under the show system command.

To execute a command, you enter the full command name, starting at the top level of the hierarchy. For example, to display a brief view of the chassis components, use the command show chassis hardware.

Configuration Statement Hierarchy

The configuration statement hierarchy has two types of statements: container statements, which are statements that contain other statements, and leaf statements, which do not contain other statements. All of the container and leaf statements together form the configuration hierarchy.

Moving Among Hierarchy Levels

You can use the CLI commands in Table 6 on page 38 to navigate the levels of the configuration statement hierarchy.
### Table 6: CLI Configuration Mode Navigation Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>edit</td>
<td>Moves to an existing configuration statement hierarchy or creates a hierarchy and moves to that level.</td>
</tr>
<tr>
<td>hierarchy-level</td>
<td></td>
</tr>
<tr>
<td>exit</td>
<td>Moves up the hierarchy to the previous level where you were working. This command is, in effect, the opposite of the <code>edit</code> command. Alternatively, you can use the <code>quit</code> command. The <code>exit</code> and <code>quit</code> commands are interchangeable.</td>
</tr>
<tr>
<td>up</td>
<td>Moves up the hierarchy one level at a time.</td>
</tr>
<tr>
<td>top</td>
<td>Moves directly to the top level of the hierarchy.</td>
</tr>
</tbody>
</table>

### Other Tools for Configuring and Monitoring Devices Running Junos OS

Apart from the command-line interface, Junos OS also supports the following applications, scripts, and utilities that enable you to configure and monitor devices running Junos OS:

- **J-Web graphical user interface (GUI)**—Allows you to monitor, configure, troubleshoot, and manage the CMC on a client by means of a Web browser with Hypertext Transfer Protocol (HTTP) or HTTP over Secure Sockets Layer (HTTPS) enabled.

- **Junos XML management protocol**—Application programmers can use the Junos XML management protocol to monitor and configure the CMC. Juniper Networks provides a Perl module with the API to help you more quickly and easily develop custom Perl scripts for configuring and monitoring devices. For more information, see the Junos XML Management Protocol Guide.

- **NETCONF Application Programming Interface (API)**—Application programmers can also use the NETCONF XML management protocol to monitor and configure the CMC. For more information, see the NETCONF XML Management Protocol Guide.

- **Junos commit scripts and self-diagnosis features**—You can define scripts to enforce custom configuration rules, use commit script macros to provide simplified aliases for frequently used configuration statements, and configure diagnostic event policies and actions associated with each policy. For more information, see the Junos Configuration and Operations Automation Guide.

- **MIBs**—You can use enterprise-specific and standard MIBs to retrieve information about the hardware and software components. For more information about MIBs, see the Junos Network Management Configuration Guide.
CHAPTER 8

Getting Started: A Quick Tour

- Getting Started with the Junos OS Command-Line Interface on page 39
- Switching Between Junos OS CLI Operational and Configuration Modes on page 40
- Configuring a User Account on a Device Running Junos OS on page 41
- Checking the Status of a Device Running Junos OS on page 43
- Rolling Back Junos OS Configuration Changes on page 44

Getting Started with the Junos OS Command-Line Interface

As an introduction to the Junos OS command-line interface (CLI), this topic provides instructions for simple steps you take after installing Junos OS on the device. It shows you how to start the CLI, view the command hierarchy, and make small configuration changes. The related topics listed at the end of this topic provide more detailed information about using the CLI.

NOTE: Before you begin, make sure your device hardware is set up and Junos OS is installed. You must have a direct console connection to the device or network access using SSH or Telnet.

To log in and start the CLI:

1. Log in as root.
   The root login account has superuser privileges, with access to all commands and statements.

2. Start the CLI:
   root# cli
   root@>
   The > command prompt shows that you are in operational mode. Later, when you enter configuration mode, the prompt will change to #.

The CLI includes several ways to get help for commands. This section shows some examples of how to get help:

1. Type ? to show the top-level commands available in operational mode.
root@> ?
Possible completions:
clear Clear information in the system
configure Manipulate software configuration information
file Perform file operations
help Provide help information
monitor Show real-time debugging information
mtrace Trace multicast path from source to receiver
op Invoke an operation script
ping Ping remote target
quit Exit the management session
request Make system-level requests
restart Restart software process
set Set CLI properties, date/time, craft interface message
show Show system information
ssh Start secure shell on another host
start Start shell
telnet Telnet to another host
test Perform diagnostic debugging
traceroute Trace route to remote host

2. Type file ? to show all possible completions for the file command.

root@> file ?
Possible completions:
<[Enter]> Execute this command
archive Archives files from the system
checksum Calculate file checksum
compare Compare files
copy Copy files (local or remote)
delete Delete files from the system
list List file information
rename Rename files
show Show file contents
source-address Local address to use in originating the connection
| Pipe through a command

3. Type file archive ? to show all possible completions for the file archive command.

root@> file archive ?
Possible completions:
compress Compresses the archived file using GNU gzip (.tgz)
destination Name of created archive (URL, local, remote, or floppy)
source Path of directory to archive

Switching Between Junos OS CLI Operational and Configuration Modes

When you monitor and configure a device running Junos OS, you may need to switch between operational mode and configuration mode. When you change to configuration mode, the command prompt also changes. The operational mode prompt is a right angle bracket (>, and the configuration mode prompt is a pound sign (#).

To switch between operational mode and configuration mode:
1. When you log in to the CMC and type the `cli` command, you are automatically in operational mode:

   --- JUNOS 9.2B1.8 built 2008-05-09 23:41:29 UTC
   % cli
   user@host>

2. To enter configuration mode, type the `configure` command or the `edit` command from the CLI operation mode. For example:

   user@host> configure
   Entering configuration mode

   [edit]
   user@host#

   The CLI prompt changes from `user@host>` to `user@host#`, and a banner appears to indicate the hierarchy level.

3. You can return to operational mode in one of the following ways:

   - To commit the configuration and exit:

     [edit]
     user@host# commit and-quit
     commit complete
     Exiting configuration mode
     user@host>

   - To exit without committing:

     [edit]
     user@host# exit
     Exiting configuration mode
     user@host>

   When you exit configuration mode, the CLI prompt changes from `user@host#` to `user@host>`, and the banner no longer appears. You can enter or exit configuration mode as many times as you wish without committing the changes.

4. To display the output of an operational mode command, such as `show`, while in configuration mode, issue the `run` configuration mode command, and then specify the operational mode command:

   [edit]
   user@host# run operational-mode-command

---

**Configuring a User Account on a Device Running Junos OS**

This topic describes how to log in to a device running Junos OS, using a root account, and configure a new user account. You can configure an account for your own use or create a test account.

To configure a new user account on the device:

1. Log in as `root` and enter configuration mode:
root@host> configure
[edit]
root@host#

The prompt in brackets ([edit]), also known as a **banner**, shows that you are in configuration edit mode at the top of the hierarchy.

2. Change to the [edit system login] section of the configuration:

```
[edit]
root@host# edit system login
[edit system login]
root@host#
```

The prompt in brackets changes to [edit system login] to show that you are at a new level in the hierarchy.

3. Now add a new user account:

```
[edit system login]
root@host# edit user dwinchester
```

This example adds an account **dwinchester** (for Dean Winchester).

4. Configure a full name for the account. If the name includes spaces, enclose the entire name in quotation marks (" "):

```
[edit system login user dwinchester]
root@host# set full-name "Dean Winchester"
```

5. Configure an account class. The account class sets the user access privileges for the account:

```
[edit system login user dwinchester]
root@host# set class super-user
```

6. Configure an authentication method and password for the account:

```
[edit system login user dwinchester]
root@host# set authentication plain-text-password
```

When the new password prompt appears, enter a clear-text password that the system can encrypt, and then confirm the new password.

7. Commit the configuration:

```
[edit system login user dwinchester]
root@host# commit
commit complete
```

Configuration changes are not activated until you commit the configuration. If the commit is successful, a **commit complete** message appears.

8. Return to the top level of the configuration, and then exit:

```
[edit system login user dwinchester]
root@host# top
[edit]
root@host# exit
Exiting configuration mode
```
9. Log out of the device:

   root@host> exit
   % logout Connection closed.

10. To test your changes, log back in with the user account and password you just configured:

    login: dwinchester
    Password: password
    --- Junos 8.3-R1.1 built 2005-12-15 22:42:19 UTC
    dwinchester@host>

    When you log in, you should see the new username at the command prompt.

You have successfully used the CLI to view the device status and to perform a simple configuration change.

**NOTE:** For complete information about the commands for configuring your device, including examples, see the Junos OS configuration guides.

### Checking the Status of a Device Running Junos OS

You can use `show` commands to check the status of the device and monitor the activities on the device.

To become familiar with `show` commands:

- Type `show ?` to display the list of `show` commands that you can use to monitor the CMC:

  root@> show ?
  Possible completions:
  accounting       Show accounting profiles and records
  arp              Show system Address Resolution Protocol table entries
  ...

- Use the `show chassis routing-engine` command to view the RE status:

  root@> show chassis routing-engine
  Routing Engine status:
  DRAM                      2040 MB
  Memory utilization      15 percent
  CPU utilization:
  User                       0 percent
  Background                 0 percent
  Kernel                     14 percent
  Interrupt                  1 percent
  Idle                       85 percent
  Model                          RE-MAG-CM060
  Serial ID                      CMC_SER
  Start time                     2011-02-28 21:27:00 IST
  Uptime                         8 days, 6 hours, 24 minutes, 21 seconds
  Last reboot reason            Device rebooted after a normal shutdown.
  Load averages:                1 minute 5 minute 15 minute
                                  0.44  1.05  1.02
• Use the `show system storage` command to view the available storage on the device:

```
root@> show system storage
```

<table>
<thead>
<tr>
<th>Filesystem</th>
<th>Size</th>
<th>Used</th>
<th>Avail</th>
<th>Capacity</th>
<th>Mounted on</th>
</tr>
</thead>
<tbody>
<tr>
<td>/dev/ad1s1a</td>
<td>904M</td>
<td>726M</td>
<td>106M</td>
<td>87%</td>
<td>/</td>
</tr>
<tr>
<td>devfs</td>
<td>1.0K</td>
<td>1.0K</td>
<td>0B</td>
<td>100%</td>
<td>/dev</td>
</tr>
<tr>
<td>/dev/md0</td>
<td>415M</td>
<td>415M</td>
<td>0B</td>
<td>100%</td>
<td>/junos</td>
</tr>
<tr>
<td>/cf</td>
<td>904M</td>
<td>726M</td>
<td>106M</td>
<td>87%</td>
<td>/junos/cf</td>
</tr>
<tr>
<td>devfs</td>
<td>1.0K</td>
<td>1.0K</td>
<td>0B</td>
<td>100%</td>
<td>/junos/dev/</td>
</tr>
<tr>
<td>procfs</td>
<td>4.0K</td>
<td>4.0K</td>
<td>0B</td>
<td>100%</td>
<td>/proc</td>
</tr>
<tr>
<td>/dev/ad1s1e</td>
<td>100M</td>
<td>18K</td>
<td>92M</td>
<td>0%</td>
<td>/config</td>
</tr>
<tr>
<td>/dev/ad1s1f</td>
<td>144G</td>
<td>2.6G</td>
<td>130G</td>
<td>2%</td>
<td>/var</td>
</tr>
<tr>
<td>/dev/md1</td>
<td>1007M</td>
<td>526K</td>
<td>926M</td>
<td>0%</td>
<td>/mfs</td>
</tr>
<tr>
<td>/var/jail</td>
<td>144G</td>
<td>2.6G</td>
<td>130G</td>
<td>2%</td>
<td>/jail/var</td>
</tr>
<tr>
<td>/var/log</td>
<td>144G</td>
<td>2.6G</td>
<td>130G</td>
<td>2%</td>
<td>/jail/var/log</td>
</tr>
<tr>
<td>devfs</td>
<td>1.0K</td>
<td>1.0K</td>
<td>0B</td>
<td>100%</td>
<td>/jail/dev</td>
</tr>
</tbody>
</table>

**Rolling Back Junos OS Configuration Changes**

This topic shows how to use the `rollback` command to return to the most recently committed Junos OS configuration. The `rollback` command is useful if you make configuration changes and then decide not to keep the changes.

The following procedure shows how to configure a Simple Network Management Protocol (SNMP) health monitor on a device running Junos OS and then return to the most recently committed configuration that does not include the health monitor. When configured, the SNMP health monitor provides the network management system (NMS) with predefined monitoring for file system usage, CPU usage, and memory usage on the device.

1. Enter configuration mode:
   ```
   user@host> configure
   entering configuration mode
   [edit]
   user@host#
   ```

2. Show the current configuration (if any) for SNMP:
   ```
   [edit]
   user@host# show snmp
   ```

   No `snmp` statements appear because SNMP has not been configured on the device.

3. Configure the health monitor:
   ```
   [edit]
   user@host# set snmp health-monitor
   ```

4. Show the new configuration:
   ```
   [edit]
   user@host# show snmp
   health-monitor;
   ```

   The `health-monitor` statement indicates that SNMP health monitoring is configured on the device.
5. Enter the **rollback** configuration mode command to return to the most recently committed configuration:

   [edit]
   user@host# rollback
   load complete

6. Show the configuration again to make sure your change is no longer present:

   [edit]
   user@host# show snmp

   No **snmp** configuration statements appear. The health monitor is no longer configured.

7. Enter the **commit** command to activate the configuration to which you rolled back:

   [edit]
   user@host# commit

8. Exit configuration mode:

   [edit]
   user@host# exit
   Exiting configuration mode

You can also use the **rollback** command to return to earlier configurations.
CHAPTER 9

Getting Online Help

• Getting Online Help from the Junos OS Command-Line Interface on page 47
• Junos OS CLI Online Help Features on page 49
• Displaying the Junos OS CLI Command and Word History on page 51

Getting Online Help from the Junos OS Command-Line Interface

The Junos OS command-line interface (CLI) has a context-sensitive online help feature that enables you to access information about commands and statements from the Junos OS CLI. This topic contains the following sections:

• Getting Help For Commands on page 47
• Getting Help For a String in a Statement or Command on page 48
• Getting Help For Configuration Statements on page 49
• Getting Help For System Log Messages on page 49

Getting Help For Commands

Information about commands is provided at each level of the CLI command hierarchy. You can type a question mark to get help about commands:

• If you type the question mark at the command-line prompt, the CLI lists the available commands and options. For example, to view a list of top-level operational mode commands, type a question mark (?) at the command-line prompt.

user@host> ?
Possible completions:
   clear Clear information in the system
   configure Manipulate software configuration information
   file Perform file operations
   help Provide help information
   monitor Show real-time debugging information
   mtrace Trace multicast path from source to receiver
   op Invoke an operation script
   ping Ping remote target
   quit Exit the management session
   request Make system-level requests
   restart Restart software process
   set Set CLI properties, date/time, craft interface message
   show Show system information
   ssh Start secure shell on another host
start                Start shell
telnet               Telnet to another host
test                 Perform diagnostic debugging
traceroute           Trace route to remote

• If you type the question mark after entering the complete name of a command or command option, the CLI lists the available commands and options and then redisplays the command names and options that you typed.

root@> file ?

Possible completions:
  <[Enter]>            Execute this command
  archive              Archives files from the system
  checksum             Calculate file checksum
  compare              Compare files
  copy                  Copy files (local or remote)
  delete                Delete files from the system
  list                  List file information
  rename                Rename files
  show                  Show file contents
  source-address        Local address to use in originating the connection
  |                     Pipe through a command

• If you type the question mark in the middle of a command name, the CLI lists possible command completions that match the letters you have entered so far. It then redisplays the letters that you typed. For example, to list all operational mode commands that start with the letter c, type the following:

user@host> c?

Possible completions:
  clear      Clear information in the system
  configure  Manipulate software configuration information

• For introductory information on using the question mark or the help command, you can also type help and press Enter:

user@host> help

Getting Help For a String in a Statement or Command

You can use the help command to display help about a text string contained in a statement or command name:

help apropos string

string is a text string for which you want to get help. This string is used to match statement or command names as well as to match the help strings that are displayed for the statements or commands.

If the string contains spaces, enclose it in quotation marks (" "). You can also specify a regular expression for the string, using standard UNIX-style regular expression syntax.

In configuration mode, this command displays statement names and help text that match the string specified. In operational mode, this command displays command names and help text that match the string specified.
Getting Help For Configuration Statements

You can display help based on text contained in a statement name, using the `help topic` and `help reference` commands:

```
help topic word
help reference statement-name
```

The `help topic` command displays usage guidelines for the statement, based on information that appears in the Junos configuration guides. The `help reference` command displays summary information about the statement, based on the summary descriptions that appear in the Junos configuration guides.

Getting Help For System Log Messages

You can display help based on a system log tag, using the `help syslog` command:

```
help syslog syslog-tag
```

The `help syslog` command displays the contents of a system log message.

Junos OS CLI Online Help Features

The Junos OS CLI online help provides the following features for ease of use and error prevention:

- Help for Omitted Statements on page 49
- Using CLI Command Completion on page 50
- Using Command Completion in Configuration Mode on page 50
- Displaying Tips For CLI Commands on page 50

Help for Omitted Statements

If you have omitted a required statement at a particular hierarchy level, when you attempt to move from that hierarchy level or when you issue the `show` command in configuration mode, a message indicates which statement is missing. For example:

```
[edit protocols pim interface so-0/0/0]
user@host# top
Warning: missing mandatory statement: 'mode'
[edit]
user@host# show
protocols {
   pim {
      interface so-0/0/0 {
         priority 4;
         version 2;
         # Warning: missing mandatory statement(s): 'mode'
      }
   }
}
```
Using CLI Command Completion

The Junos OS CLI provides you a command completion option that enables Junos OS to recognize commands and options based on the initial few letters you typed. That is, you do not always have to remember or type the full command or option name for the CLI to recognize it.

- To display all possible command or option completions, type the partial command followed immediately by a question mark.
- To complete a command or option that you have partially typed, press Tab or the Spacebar. If the partially typed letters begin a string that uniquely identifies a command, the complete command name appears. Otherwise, a prompt indicates that you have entered an ambiguous command, and the possible completions are displayed.

Command completion also applies to other strings, such as filenames, interface names, and usernames. To display all possible values, type a partial string followed immediately by a question mark. To complete a string, press Tab.

Using Command Completion in Configuration Mode

The CLI command completion functions also apply to the commands in configuration mode and to configuration statements. Specifically, to display all possible commands or statements, type the partial string followed immediately by a question mark. To complete a command or statement that you have partially typed, press Tab or the Spacebar.

Command completion also applies to identifiers, with one slight difference. To display all possible identifiers, type a partial string followed immediately by a question mark. To complete an identifier, you must press Tab. This scheme allows you to enter identifiers with similar names; then press the Spacebar when you are done typing the identifier name.

Displaying Tips For CLI Commands

To get tips for CLI commands, issue the **help tip cli** command. Each time you enter the command, a new tip appears. For example:

```bash
user@host> help tip cli
Junos tip:
Use 'request system software validate' to validate the incoming software against the current configuration without impacting the running system.
user@host> help tip cli
Junos tip:
Use 'commit and-quit' to exit configuration mode after the commit has succeeded. If the commit fails, you are left in configuration mode.
```

You can also enter **help tip cli number** to associate a tip with a number. This enables you to recall the tip at a later time. For example:

```bash
user@host> help tip cli 10
JUNOS tip:
Use '#' in the beginning of a line in command scripts to cause the rest of the line to be ignored.
```
user@host> help tip cli
JUNOS tip:
Use the 'apply-groups' statement at any level of the configuration
hierarchy to inherit configuration statements from a configuration group.

user@host>

Displaying the Junos OS CLI Command and Word History

To display a list of recent commands that you issued, use the show cli history command:

user@host> show cli history 3
  01:01:44 -- show interfaces terse
  01:01:51 -- show cli history
  01:02:51 -- show cli history 3

You can press Esc+. (period) or Alt+. (period) to insert the last word of the previous
command. Repeat Esc+. or Alt+. to scroll backward through the list of recently entered
words. For example:

user@host> show interfaces terse em0
Interface               Admin Link Proto    Local                 Remote
em0                     up    up
em0.0                   up    up   inet     10.64.100.98/16
user@host> <Esc>
user@host> em0

If you scroll completely to the beginning of the list, pressing Esc+. or Alt+. again restarts
scrolling from the last word entered.
**show chassis alarms**

**Syntax**

show chassis alarms

**Description**

Monitors chassis alarms to troubleshoot hardware problems on a Junos Pulse Gateway. You can also view chassis properties by selecting Monitor > System View > Chassis Information or Monitor > Events and Alarms > View Alarms in the J-Web interface.

**Options**

None

**Additional Information**

The show chassis alarms command does not display the Flexible PIC Concentrator (FPC) slot number under high temperature conditions.

**Sample Output**

```
user@host> show chassis alarms
1 alarms currently active
Alarm time                  Class        Description
2011-05-04 02:15:19 UTC     Major        Temperature Warm
```

Use SNMP traps to determine the FPC slot number.

```
user@host> show chassis alarms
1 alarms currently active
Alarm time                  Class        Description
2011-05-04 02:15:19 UTC     Major        Fan Tray 7 Failure
```
### show chassis environment

**Syntax**
show chassis environment (fpc number | routing-engine)

**Description**
Displays the Junos Pulse Gateway chassis environment information, such as power, temperature and fan status.

**Options**
- none—Displays environment information about all installed components.
- fpc number—Displays environment information about the specified Flexible PIC Concentrator (FPC). If you do not specify an FPC number, the status of all FPCs is displayed.
- routing-engine—Currently not supported.

**List of Sample Output**
- show chassis environment on page 55
- show chassis environment fpc on page 55
- show chassis environment fpc 1 on page 56

**Output Fields**
- State—Status of the FPC, online or offline.
- Temperature—Temperature of the air flowing past the FPC.

**Sample Output**

```plaintext
user@host> show chassis environment
Class    Item                           Status     Measurement
Power    PEM 0                          Check
         PEM 1                          OK
Temp     FPC 1                          OK         39 degrees C / 102 degrees F
         FPC 3                          OK         24 degrees C / 75 degrees F
         FPC 7                          OK         53 degrees C / 127 degrees F
Fans     Tray 0 Fan 0                   OK         Spinning at normal speed
         Tray 0 Fan 1                   OK         Spinning at normal speed
         Tray 1 Fan 0                   OK         Spinning at normal speed
         Tray 1 Fan 1                   OK         Spinning at normal speed
         Tray 2 Fan 0                   OK         Spinning at normal speed
         Tray 2 Fan 1                   OK         Spinning at normal speed
         Tray 3 Fan 0                   OK         Spinning at normal speed
         Tray 3 Fan 1                   OK         Spinning at normal speed
         Tray 4 Fan 0                   Failed
         Tray 4 Fan 1                   Failed

user@host> show chassis environment fpc
FPC 1 status:
  State                      Online
  Temperature                39 degrees C / 102 degrees F
FPC 3 status:
  State                      Online
  Temperature                24 degrees C / 75 degrees F
FPC 7 status:
  State                      Online
  Temperature                53 degrees C / 127 degrees F
```
user@host> show chassis environment fpc 1
FPC 1 status:
  State               Online
  Temperature        39 degrees C / 102 degrees F
show chassis fan

**Syntax**
```
show chassis fan
```

**Description**
Show information about the fan tray and fans.

**Options**
None

**Output Fields**
- **Item**—Fan item identifier.
- **Status**—Status of the fan:
  - OK—Fan is running properly and within the normal range.
  - Failed—Fan is not running.
- **RPM**—Fan speed in revolutions per minute (RPM).
- **Measurement**—Fan speed status.

**Sample Output**
```
show chassis fan
user@host> show chassis fan

<table>
<thead>
<tr>
<th>Item</th>
<th>Status</th>
<th>RPM</th>
<th>Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 0 Fan 0</td>
<td>OK</td>
<td>3068</td>
<td>Spinning at normal speed</td>
</tr>
<tr>
<td>Tray 0 Fan 1</td>
<td>OK</td>
<td>3245</td>
<td>Spinning at normal speed</td>
</tr>
<tr>
<td>Tray 1 Fan 0</td>
<td>OK</td>
<td>3375</td>
<td>Spinning at normal speed</td>
</tr>
<tr>
<td>Tray 1 Fan 1</td>
<td>OK</td>
<td>3308</td>
<td>Spinning at normal speed</td>
</tr>
<tr>
<td>Tray 2 Fan 0</td>
<td>OK</td>
<td>3068</td>
<td>Spinning at normal speed</td>
</tr>
<tr>
<td>Tray 2 Fan 1</td>
<td>OK</td>
<td>3183</td>
<td>Spinning at normal speed</td>
</tr>
<tr>
<td>Tray 3 Fan 0</td>
<td>OK</td>
<td>3443</td>
<td>Spinning at normal speed</td>
</tr>
<tr>
<td>Tray 3 Fan 1</td>
<td>OK</td>
<td>3245</td>
<td>Spinning at normal speed</td>
</tr>
<tr>
<td>Tray 4 Fan 0</td>
<td>Failed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tray 4 Fan 1</td>
<td>Failed</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```
show chassis firmware

**Syntax**

```
show chassis firmware
```

**Description**

Displays the firmware version levels of the application modules installed in the Junos Pulse Gateway.

**Options**

None

**Output Fields**

- **Part**—Flexible PIC concentrator (FPC) number.
- **Type**—Type of firmware, such as operating system.
- **Version**—Version of firmware running on the FPC.

**Sample Output**

```
user@host> show chassis firmware

<table>
<thead>
<tr>
<th>Part</th>
<th>Type</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>FPC 1</td>
<td>O/S</td>
<td>7.1R2 18200</td>
</tr>
<tr>
<td>FPC 3</td>
<td>O/S</td>
<td>4.1R2:EA1 17310</td>
</tr>
</tbody>
</table>
```
**show chassis fpc**

**Syntax**

```
show chassis fpc (fpc-slot-number | detail | pic-status)
```

**Description**
Display status information about the installed Flexible PIC Concentrators (FPCs) and Physical Interface Cards (PICs).

**Options**

- **None**—Display status information for all FPCs.
- **Detail**—(Optional) Display detailed status information for all FPCs or for the FPC in the specified slot (see `fpc-slot`).
- **fpc-slot**—(Optional) FPC slot number. Replace `fpc-slot` with a valid number.
- **pic-status**—(Optional) Display status information for all PICs.

**List of Sample Output**

- `show chassis fpc` on page 59
- `show chassis fpc 1` on page 60
- `show chassis fpc 1 detail` on page 60
- `show chassis fpc detail` on page 60
- `show chassis fpc pic-status` on page 60

**Output Fields**

- **Slot**—Slot number.
- **Temp (C) or Temperature**—Temperature of the air passing by the FPC, in degrees Celsius or in both Celsius and Fahrenheit.
- **Total CPU Utilization (%)**—Total percentage of CPU being used by the FPC's processor.
- **Interrupt CPU Utilization (%)**—Of the total CPU being used by the FPC's processor, the percentage being used for interrupts.
- **Memory DRAM (MB)**—
- **Heap Utilization (%)**—Percentage of heap space (dynamic memory) being used by the FPC’s processor. If this number exceeds 80 percent, there may be a software problem (memory leak).
- **Buffer Utilization (%)**—Percentage of buffer space being used by the FPC's processor for buffering internal messages.
- **Total CPU DRAM**—Amount of DRAM available to the FPC's CPU.
- **Uptime**—How long the FPC has been up and running.
- **Start time**—Time when it was detected that the FPC was running.

**Sample Output**

```
user@host> show chassis fpc
Slot  State  Temp (C)  CPU Utilization (%)  Memory Utilization (%)
```

---

Copyright © 2012, Juniper Networks, Inc.
show chassis fpc 1
user@host> show chassis fpc 1

Temp  CPU Utilization (%)   Memory    Utilization (%)
Slot State            (C)  Total  Interrupt      DRAM (MB) Heap     Buffer
1  Online            39      1                  4048

show chassis fpc 1 detail
user@host> show chassis fpc 1 detail

Slot 1 information:
State                               Online
Temperature                      39 degrees C / 102 degrees F
Total CPU DRAM                 4048 MB
Uptime                              9 days, 7 hours, 15 minutes, 5 seconds
Start time                          2011-05-07 02:50:29 IST

Slot 3 information:
State                               Online
Temperature                      24 degrees C / 75 degrees F
Total CPU DRAM                 2024 MB
Uptime                              9 days, 7 hours, 6 minutes, 50 seconds
Start time                          2011-05-07 02:50:26 IST

Slot 7 information:
State                               Online
Temperature                      53 degrees C / 127 degrees F
Total CPU DRAM                 24336 MB
Uptime                              9 days, 7 hours, 6 minutes, 8 seconds
Start time                          2011-05-07 02:51:08 IST

show chassis fpc pic-status
user@host> show chassis fpc pic-status

Slot 1  Online   MAG-SM360
Slot 3  Online   MAG-SM160
Slot 4  Online   MAG-CM060
**show chassis hardware**

**Syntax**  
show chassis hardware (detail | extensive | models)

**Description**  
Display a list of all installed Flexible PIC Concentrators (FPCs) and Physical Interface Cards (PICs), including the hardware version level and serial number.

**Options**  
None—Display hardware information.

detail—(Optional) Include RAM and disk information in output.

extensive—(Optional) Display ID EEPROM information.

models—Display model numbers and part numbers for orderable field replaceable units (FRUs).

**Additional Information**  
The **show chassis hardware** CLI command shows only 12-digits of the 16-digit serial number for the service modules and MAG-CM060. To complete the 16-digit serial number, prefix the output from the **show chassis hardware** CLI command as follows:

<table>
<thead>
<tr>
<th>Model Number</th>
<th>Prefix the Serial Number With</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAG-CM060</td>
<td>0272</td>
</tr>
<tr>
<td>MAG-SM160</td>
<td>0284</td>
</tr>
<tr>
<td>MAG-SM360</td>
<td>0285</td>
</tr>
<tr>
<td>MAG-SM161</td>
<td>0292</td>
</tr>
<tr>
<td>MAG-SM361</td>
<td>0293</td>
</tr>
</tbody>
</table>

**List of Sample Output**  
show chassis hardware detail on page 62  
show chassis hardware extensive on page 62  
show chassis hardware models on page 63

**Output Fields**  
Item—Chassis component.

Version—Revision level of the chassis component.

Part Number—Part number of the chassis component.

Serial Number—Serial number of the chassis component. Use this serial number when you need to contact Juniper Networks Customer Support about the chassis.

Assb ID or Assembly ID—(extensive output only) Identification number that describes the FRU hardware.

FRU model number—Model number of the FRU hardware component.
EEPROM Version—ID EEPROM version used by the hardware component: 0x01 (version 1) or 0x02 (version 2).

Description—Brief description of the hardware item.

**show chassis hardware**
```bash
cmcc-15> show chassis hardware
Hardware inventory:
Item           Version  Part number  Serial number     Description
Chassis                          022011000013      MAG6611
Midplane                 650-036297   022011000013      MAG6611 Midplane
PEM 0                                   MAG6611 Power Supply
PEM 1                                   MAG6611 Power Supply
FPC 1            1.0      650-036300   022011000016      MAG-SM360
IPC         REV 01  BUILTIN  BUILTIN                     3 port non-bypass IPC
HDD 0 NA          NA          NA                      HDD in tray
HDD 1 NA          NA          NA                      HDD in tray
Fan Tray 0                               Fan Tray 0
Fan Tray 1                               Fan Tray 1
```

**show chassis hardware detail**
```bash
cmcc-15> show chassis hardware detail
Hardware inventory:
Item           Version  Part number  Serial number     Description
Chassis                          022011000013      MAG6611
Midplane                 650-036297   022011000013      MAG6611 Midplane
PEM 0                                   MAG6611 Power Supply
PEM 1                                   MAG6611 Power Supply
FPC 1            1.0      650-036300   022011000016      MAG-SM360
IPC         REV 01  BUILTIN  BUILTIN                     3 port non-bypass IPC
HDD 0 NA          NA          NA                      HDD in tray
HDD 1 NA          NA          NA                      HDD in tray
Fan Tray 0                               Fan Tray 0
Fan Tray 1                               Fan Tray 1
FPC 3            1.0      650-036300   022011000017      MAG-SM360
IPC         REV 01  BUILTIN  BUILTIN                     3 port non-bypass IPC
HDD 2 NA          NA          NA                      HDD in tray
HDD 3 NA          NA          NA                      HDD in tray
Fan Tray 2                               Fan Tray 2
Fan Tray 3                               Fan Tray 3
```

**show chassis hardware extensive**
```bash
cmcc-15> show chassis hardware extensive
Hardware inventory:
Item           Version  Part number  Serial number     Description
Chassis                          022011000013      MAG6611
Jedec Code:   0x7fb0            EEPROM Version:    0x02
S/N:               022011000013
Assembly ID:  0x054b            Assembly Version:  00.00
Date:         00-00-0000        Assembly Flags:    0x00
ID: MAG6611
Board Information Record:
Address 0x00: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
12C Hex Data:
Address 0x00: 7f b0 02 ff 05 4b 00 00 00 00 00 00 00 00 00 00
Address 0x10: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
Address 0x20: 30 32 32 30 31 31 30 30 30 31 33 00 00 00 00
Address 0x30: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
Address 0x40: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
Address 0x50: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
```
show chassis hardware models

root@CMC-15> show chassis hardware models
Hardware inventory:

<table>
<thead>
<tr>
<th>Item</th>
<th>Version</th>
<th>Part number</th>
<th>Serial number</th>
<th>FRU model number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Midplane</td>
<td></td>
<td>650-036297</td>
<td>022011000013</td>
<td>MAG6611</td>
</tr>
<tr>
<td>PEM 0</td>
<td>1.0</td>
<td>650-036300</td>
<td>022011000016</td>
<td>MAG-SM360</td>
</tr>
<tr>
<td>PEM 1</td>
<td>1.0</td>
<td>650-036298</td>
<td>022011000014</td>
<td>MAG-SM160</td>
</tr>
<tr>
<td>FPC 3</td>
<td>1.0</td>
<td>650-036300</td>
<td>022011000017</td>
<td>MAG-SM360</td>
</tr>
<tr>
<td>HDD 4</td>
<td>SN01</td>
<td>9XE00EHN</td>
<td></td>
<td>MAG-HD060</td>
</tr>
<tr>
<td>Fan Tray 4</td>
<td></td>
<td></td>
<td></td>
<td>MAG-FT060</td>
</tr>
<tr>
<td>FPC 6</td>
<td>1.0</td>
<td>650-036303</td>
<td>022011000001</td>
<td>MAG-CM260</td>
</tr>
<tr>
<td>HDD 6</td>
<td>SN01</td>
<td>9XE00DCA</td>
<td></td>
<td>MAG-HD060</td>
</tr>
<tr>
<td>Fan Tray 6</td>
<td></td>
<td></td>
<td></td>
<td>MAG-FT060</td>
</tr>
</tbody>
</table>
show chassis routing-engine

**Syntax**
show chassis routing-engine (bios)

**Description**
Display the status of the MAG-CM060.

**Options**
- none—Display information about the MAG-CM060.
- bios—(Optional) Display the basic input/output system (BIOS) firmware version.

**List of Sample Output**
- show chassis routing-engine on page 65
- show chassis routing-engine bios on page 65

**Output Fields**
- DRAM—Total DRAM available to the processor.
- Memory utilization—Percentage of memory being used.
- CPU utilization—Information about the CPU utilization:
  - User—Percentage of CPU time being used by user processes.
  - Background—Percentage of CPU time being used by background processes.
  - Kernel—Percentage of CPU time being used by kernel processes.
  - Interrupt—Percentage of CPU time being used by interrupts.
  - Idle—Percentage of CPU time that is idle.
- Model—MAG-CM060 model number.
- Serial ID—Identification number of the MAG-CM060 in this slot.
- Start Time—Time at which the MAG-CM060 started running.
- Uptime—How long the MAG-CM060 has been running.
- Last reboot reason—Reason for last reboot, including:
  - rebooted after a normal shutdown—Reboot due to a normal shutdown.
  - could not be determined—Reboot due to an undetermined reason.
  - bios auto recovery reset—Reboot due to a BIOS auto-recovery reset.
  - chassis control reset—Reboot due to a chassis control reset.
  - reset from debugger—Reboot due to reset from the debugger.
  - hard disk failure—Reboot due to a hard disk failure.
  - power cycle/failure—Reboot due to the switching off of the power button behind the Routing Engine, not the power button on the chassis.
  - reset-button reset—Reboot due to pressing of the reset button on the MAG-CM060.
- power-button hard power off—Reboot due to pressing of the power button.
- misc hardware reason—Reboot due to miscellaneous hardware reasons.

Load averages—MAG-CM060 load averages for the last 1, 5, and 15 minutes.

### Sample Output

```bash
chapter 10: CLI Commands for Monitoring the Junos Pulse Gateway

- power-button hard power off—Reboot due to pressing of the power button.
- misc hardware reason—Reboot due to miscellaneous hardware reasons.

Load averages—MAG-CM060 load averages for the last 1, 5, and 15 minutes.

### Sample Output

```bash
chapter 10: CLI Commands for Monitoring the Junos Pulse Gateway

- power-button hard power off—Reboot due to pressing of the power button.
- misc hardware reason—Reboot due to miscellaneous hardware reasons.

Load averages—MAG-CM060 load averages for the last 1, 5, and 15 minutes.

### Sample Output

```bash
chapter 10: CLI Commands for Monitoring the Junos Pulse Gateway

- power-button hard power off—Reboot due to pressing of the power button.
- misc hardware reason—Reboot due to miscellaneous hardware reasons.

Load averages—MAG-CM060 load averages for the last 1, 5, and 15 minutes.

### Sample Output

```bash
chapter 10: CLI Commands for Monitoring the Junos Pulse Gateway

- power-button hard power off—Reboot due to pressing of the power button.
- misc hardware reason—Reboot due to miscellaneous hardware reasons.

Load averages—MAG-CM060 load averages for the last 1, 5, and 15 minutes.

### Sample Output

```bash
chapter 10: CLI Commands for Monitoring the Junos Pulse Gateway

- power-button hard power off—Reboot due to pressing of the power button.
- misc hardware reason—Reboot due to miscellaneous hardware reasons.

Load averages—MAG-CM060 load averages for the last 1, 5, and 15 minutes.

### Sample Output

```bash
chapter 10: CLI Commands for Monitoring the Junos Pulse Gateway

- power-button hard power off—Reboot due to pressing of the power button.
- misc hardware reason—Reboot due to miscellaneous hardware reasons.

Load averages—MAG-CM060 load averages for the last 1, 5, and 15 minutes.

### Sample Output

```bash
chapter 10: CLI Commands for Monitoring the Junos Pulse Gateway

- power-button hard power off—Reboot due to pressing of the power button.
- misc hardware reason—Reboot due to miscellaneous hardware reasons.

Load averages—MAG-CM060 load averages for the last 1, 5, and 15 minutes.
show snmp mib

Syntax
show snmp mib (get | get-next | walk) <name | “name name name ..”>

Description
Display local Simple Network Management Protocol (SNMP) Management Information Base (MIB) object values.

Options
get—Retrieve and display one or more SNMP object values.
get-next—Retrieve and display the next SNMP object values.
walk—Retrieve and display the SNMP object values that are associated with the requested object identifier (OID). When you use this option, the JUNOS software displays the objects below the subtree that you specify.

name—The object can be represented by a sequence of dotted integers (such as 1.3.6.1.2.1.2) or by its subtree name (such as interfaces). When entering multiple objects, enclose the objects in quotation marks.

List of Sample Output
show snmp mib get on page 66
show snmp mib get (multiple objects) on page 66
show snmp mib get-next on page 66
show snmp mib get-next (specify an OID) on page 66
show snmp mib walk name on page 66

Sample Output

show snmp mib get
user@host> show snmp mib get sysObjectID.0
sysObjectID.0 = jnxProductNameMAG6611

show snmp mib get (multiple objects)
user@host> show snmp mib get "sysObjectID.0 sysUpTime.0"
sysObjectID.0 = jnxProductNameMAG6611
sysUpTime.0 = 85005926

show snmp mib get-next
user@host> show snmp mib get-next jnxMibs
jnxBoxClass.0 = jnxProductLineMAG6611.0

show snmp mib get-next (specify an OID)
user@host> show snmp mib get-next 1.3.6.1
sysDescr.0 = Juniper Networks, Inc. mag6611 Junos Pulse Gateway, kernel JUNOS 11.1R2 #0: 2011-04-15 07:52:53 UTC
builder@briath.juniper.net:/volume/build/junos/11.1/release/11.1R2/obj-i386/bsd/kernels/JUNIPER-CMC/kernel Build date: 2011-04-15 07:32:24 UTC Copyrig

show snmp mib walk name
user@host> show snmp mib walk system
sysDescr.0 = Juniper Networks, Inc. mag6611 Junos Pulse Gateway, kernel JUNOS 11.1R2 #0: 2011-04-15 07:52:53 UTC
builder@briath.juniper.net:/volume/build/junos/11.1/release/11.1R2/obj-i386/bsd/kernels/JUNIPER-CMC/kernel Build date: 2011-04-15 07:32:24 UTC Copyrig
sysObjectID.0 = jnxProductNameMAG6611
sysUpTime.0 = 85024151
sysContact.0 = darumuga
sysName.0 = CMC-12 Habanero
sysLocation.0 = Sunnyvale
sysServices.0 = 4
CHAPTER 11

CLI Commands for Controlling the Junos Pulse Gateway
request system halt

**Syntax**
request system halt

**Description**
Sends a graceful shutdown command that turns off the Junos Pulse Gateway, including the chassis management card (CMC) and all service modules. Unlike the `request system power-off` command, the `request system halt` command turns off the CMC but does not turn off power to the CMC.

**Options**
None

**Additional Information**
Pressing any key on the CMC management console restarts the CMC. When the CMC is completely operational, it starts the service modules, depending on their state in the configuration file.
**request system power-off**

**Syntax**
request system power-off

**Description**
Sends a graceful shutdown command that turns off the Junos Pulse Gateway, including the chassis management card (CMC) and all service modules. Unlike the `request system halt` command, the `request system power-off` command turns off power to the CMC.

**Options**
None

**Additional Information**
This command sends a graceful shutdown command. If a service module is not responding, this command will send a force shutdown command to that service module. It may take up to 30 seconds for that service module to turn off.

To power on the Junos Pulse Gateway, press the power switch on the back panel, or cycle power at the remote power manager (RPM). The CMC boots first, followed by the service modules (depending on the saved configuration).
request system software rollback

Syntax
request system software rollback

Description
Revert to the previously installed Junos software package.

Options
None

Additional Information
Use the show version CLI command to display the currently installed software package.

Use the file list /cf/packages command to display the files under the local /cf/packages directory. The entry that starts with junos.old shows the version of the rollback software package.

user@host> file list /cf/packages

/cf/packages:
  junos@ -> junos-11.1R2-domestic
  junos-11.1R1.14-domestic
  junos-11.1R1.14-domestic.certs
  junos-11.1R1.14-domestic.sha1
  junos-11.1R1.14-domestic.sig
  junos-11.1R2-domestic
  junos-11.1R2-domestic.certs
  junos-11.1R2-domestic.sha1
  junos-11.1R2-domestic.sig
  junos-magcmc-11.1-20101206.0-domestic.tgz
  junos-magcmc-11.1I20101201_1117_slt-builder-domestic.tgz
  junos-magcmc-11.2-20101123.0-domestic.tgz
  junos.old@ -> junos-11.1R1.14-domestic

In the above example, the rollback reverts to Junos 11.1R1.14.
set chassis fpc

Syntax  set chassis fpc number (on | off)

Description  Turns a specific Flexible PIC Concentrator (FPC) on or off.

Options  number on—Turns on the specified FPC without affecting other installed components in the Junos Pulse Gateway.

number off—Turns off the specified FPC without affecting other installed components in the Junos Pulse Gateway.

Additional Information  After running this command, wait at least 30 seconds to ensure that the FPC is powered off.

List of Sample Output  set chassis fpc (turn off) on page 73

Sample Output  

user@host> edit
# set chassis fpc 1 power off
# commit
set system services web-management session

Syntax

set system services web-management session (idle-timeout minutes | session-limit number)

Description

Sets Web management session parameters.

Options

idle-timeout minutes—Sets the Web management session timeout. The default value is 60.

session-limit number—Sets the maximum number of Web management sessions.
request system zeroize

Syntax request system zeroize

Description Erases all configuration information and resets all key values. The command deletes all data, including customized configuration and log files.

Options None

Additional Information The CMC root password is also reset with this command. After the CMC reboots, you can log in as root without entering a password. You should rerun ezsetup after running this command.

Required Privilege Not applicable.

Related Documentation
• Configuring Basic Settings on page 6

List of Sample Output request system zeroize on page 75

Sample Output

user@host> request system zeroize
warning: System will be rebooted and may not boot without configuration Erase all data, including configuration and log files? [yes,no] (no) yes

warning: zeroizing re0

Loading /boot/loader Consoles: serial port
BIOS driver C: is disk0
BIOS 607kB/2087552kB available memory

FreeBSD/i386 bootstrap loader, Revision 1.1
(builder@youcompany.com, Mon Mar 28 20:49:26 UTC 2011)
Loading /boot/default/loader.config
/kernel text-0x837a60 data-0x46a78+0x9d44c syms=[0x4+0x8f38+0x4+0xca1ee]

Hit [Enter] to boot immediately, or space bar for command prompt.
Booting [/kernel]...
platform_early_bootinit: MAG Series Early Boot Initialization
GDB: debug ports: sio
GDB: current port: sio
KDB: debugger backends: ddb gdb
KDB: current backend: ddb
Copyright (c) 1996-2011, Juniper Networks, Inc.
All rights resrved.
Copyright (c) 1992-2006 The FreeBSD Project.
The Regents of the University of California. All rights reserved.
JUNOS 11.1R1.14 #0: 2011-03-28 21:38:26 UTC
Timecounter "18254" frequency 1193182 Hz quality 0
CPU: Genuine Intel(R) CPU N270 @ 1.60GHz (1596.01-MHz 686-class CPU)
Origin = "GenuineIntel" ID = 0x106c2 Stepping = 2

Copyright © 2012, Juniper Networks, Inc.
... output truncated
CHAPTER 12

Commonly Used Commands With the Junos Pulse Gateway

This chapter lists some useful commands for the Junos Pulse Gateway.

- Commands for Displaying Chassis Information on page 77
- Validating SSO Sign-In URL on page 78
- Command for Checking Interfaces on page 78

Commands for Displaying Chassis Information

Use the `show chassis` command to obtain information about the Junos Pulse Gateway chassis, such as alarms, and hardware inventory.

Common commands include:

- `show chassis alarms` – Monitors chassis alarms to troubleshoot hardware problems
- `show chassis environment` – Displays the Junos Pulse Gateway chassis environment information, such as power, temperature and fan status.
- `show chassis fan` – Display information about the fan tray and fans.
- `show chassis firmware` – Displays the firmware version levels of the application modules installed in the Junos Pulse Gateway.
- `show chassis fpc` – Display status information about the installed FPCs and PICs.
- `show chassis hardware` – Display a list of all installed FPCs and PICs, including the hardware version level and serial number.
- `show chassis location` – Display the physical location of the chassis.
- `show chassis routing-engine` – Display the status of the MAG-CM060.
- `show chassis temperature-thresholds` – Display chassis temperature threshold settings, in degrees Celsius.
Validating SSO Sign-In URL

To check that single sign-on (SSO) is working properly, you can validate the SSO sign-in URL using the `request services` command.

`request services single-sign-on validate-signin-url fpc fpcNumber`

If validation is successful, you will see the following response:

OK: Validation succeed.

Command for Checking Interfaces

When a problem arises, an administrator will want to perform some basic checks of the network equipment to ensure that everything is functioning as expected. The “show interfaces” commands give you important details on the state of the interfaces.

`show interfaces`

`show interface interface-Name`

You can specify the interface which you would like to see the state of, or see all interfaces.

> show interfaces em0
Physical interface: em0, Enabled, Physical link is Up
  Interface index: 9, SNMP ifIndex: 17
  Description: EM0 Interface
  Type: Ethernet, Link-level type: Ethernet, MTU: 1514, Speed: 1000mbps
  Device flags : Present Running
  Interface flags: SNMP-Traps
  Link type: Full-Duplex
  Current address: 00:11:7e:0f:07:42, Hardware address: 00:11:7e:0f:07:42
  Last flapped: Never
  Input packets: 6669431
  Output packets: 17690

Logical interface em0.0 (Index 3) (SNMP ifIndex 18)
  Flags: SNMP-Traps Encapsulation: ENET2
  Input packets: 6668609
  Output packets: 17690
  Protocol inet, MTU: 1500
  Flags: Sendcast-pkt-to-re, Is-Primary
  Addresses, Flags: Is-Default Is-Preferred Is-Primary
  Destination: 10.64/16, Local: 10.64.100.91, Broadcast: 10.64.255.255
PART 4

Index

- Index on page 81
Index

Symbols
* (red asterisk) ........................................................................ 18
? icon .................................................................................. 18

A
active configuration ............................................................ 37
addresses
machine name .................................................................. 41

B
boot image ........................................................................... 21

C
candidate configuration ..................................................... 37
CLI
configuration mode
command history .................................................................. 51
navigation commands, table........................................... 38
word history ...................................................................... 51
command history
operational mode ............................................................. 51
command shell ................................................................. 35
commands
completion ..................................................................... 50
help on ............................................................................. 47
history .............................................................................. 51
commit scripts .................................................................. 38
configuration
configuration hierarchy, J-Web display ......................... 18
configuration mode, CLI
command completion ......................................................... 50
commands
rollback ........................................................................... 44
switching to operational mode ........................................ 40
configuration statements
help on .............................................................................. 49
configure command
names and addresses ......................................................... 42
container hierarchy See hierarchy
CPU load ............................................................................. 22
customer support .............................................................. xiii
  contacting JTAC .............................................................. xiii

D
dashboard
  preferences ...................................................................... 21
device module .................................................................... 21
device state ......................................................................... 22
device type ......................................................................... 22
device uptime ..................................................................... 22
exit command
  from configuration mode .............................................. 41
ezsetup script ................................................................... 6

F
FreeBSD UNIX kernel .......................................................... 36

H
health status panel
  CPU load .......................................................................... 22
  memory util ........................................................................ 22
help apropos command
  usage guidelines ............................................................ 48
help command
  usage guidelines ............................................................ 48
Help icon (?) ..................................................................... 18
help reference command
  usage guidelines ............................................................ 48
help tip cli command
  usage guidelines ............................................................ 50
history, CLI commands
  operational mode .......................................................... 51

I
inventory ................................................................................. 21

J
J-Web configuration editor
  configuration hierarchy display ................................... 18
J-Web graphical user interface (GUI) ................................. 38
J-Web interface
  Help (?) icon .................................................................. 18
  layout .............................................................................. 16
Junos XML management protocol .................................... 38

Copyright © 2012, Juniper Networks, Inc.
last configured time ............................................................... 22
layout, J-Web ................................................................. 16
memory util ................................................................. 22
operational mode, CLI
  command history ......................................................... 51
  switching to configuration mode .......................... 40
  word history ............................................................. 51
red asterisk (*) .............................................................. 18
required entry ........................................................... 18
rollback command ........................................................ 44
serial number ............................................................... 22
show cli history command
  usage guidelines ....................................................... 51
strings
  help on ........................................................................... 48
support, technical See technical support
system information panel
  boot image ................................................................. 21
  current time .............................................................. 22
  device model ............................................................ 21
  device state .............................................................. 22
  device type .............................................................. 22
  device uptime .......................................................... 22
  inventory ................................................................. 21
  last configured time ............................................... 22
  system name ............................................................ 21
system name ................................................................. 21

technical support
  contacting JTAC ........................................................ xiii
UNIX operating system ........................................... 35, 36
UNIX shell ............................................................... 36
user accounts
  configuration example ............................................. 41